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GUI Viewers
This section only applies to the following viewers: Windows Viewer, Web Viewer and Java Viewer.

Using the Entire Screen Builder GUI viewers (which run on the client workstations), you can display the
host screens. The transformation rules that have been defined with the SDK will then be applied. Any
input that the user applies to a host screen will be sent to the Entire Screen Builder Server.

Note:
The standard 24x80 terminal screen model (model 2) is supported for all GUI viewers. For the GUI
viewers, no other terminal screen models are supported at this time.

With Entire Screen Builder’s developer version (which includes the SDK), you can only connect one GUI
viewer to the Entire Screen Builder Server. This is to enable reloading and testing of the rules during 
development.

The following topics are provided:

Invoking the Windows Viewer 

Customizing the Web Viewer 

Customizing the Java Viewer 

Customizing the GUI Viewers for Open Systems 

Working with the GUI Viewers 
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Invoking the Windows Viewer
The Windows Viewer runs as a Windows application on a client workstation. This application contains
the Entire Screen Builder ActiveX control. Therefore, it does not require a browser on the client 
workstation.

To make the Windows Viewer available to all users in your environment, the administrator has to copy the
contents of the Entire Screen Builder folder "windows viewer" from the server to the client workstation.

The Windows Viewer can be invoked in different ways: 

The rules developer can invoke it from the SDK. See Working with Host Sessions in the SDK
documentation for further information. 
All other users can invoke it as described below.

 To invoke the Windows Viewer 

Execute the file EWVViewer.exe in the Entire Screen Builder folder "windows viewer".
The "Entire Screen Builder Windows Viewer" dialog box appears showing all defined connections.

The "Entire Screen Builder Windows Viewer" dialog box provides the following command buttons:

Connect Invoke the selected connection in the Windows Viewer. See Working with the GUI Viewers
for further information. 

Exit Close the "Entire Screen Builder Windows Viewer" dialog box. 

Add Add a new connection. Specify a name of your choice for the new connection. After you have
added the connection, you must edit it in order to define the client control properties. 

Edit  Edit the selected connection. The "Client Control Properties" dialog box is shown. Specify at
least the following: server address, server port and connection number. For detailed
information, see the Overview of Client Control Properties in the User Exits documentation. 

Delete Delete the selected connection. 

Rename Rename the selected connection. 
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Customizing the Web Viewer
The Entire Screen Builder Web Viewer runs in the browser of a client workstation. It runs in any browser
which supports ActiveX controls (for example, Microsoft Internet Explorer Version 5). 

This following information is provided below: 

General Information 
HTML Page

General Information
After installation, the example HTML pages ExampleAdministratorPage.htm and
ExampleEndUserPage.htm can be found in the Entire Screen Builder folder "web viewer". These pages
need to be customized by the administrator.

To make the Web Viewer available to all users in your environment, copy the file NWWClientFull.cab
and your customized HTML pages to the HTTP server. No installation is required on a client workstation.
Inform all users of the URL that is to be used to open the end-user HTML page.

Note:
NWWClientFull.cab is a signed CAB file that is certified by the VeriSign company. 
NWWClientFull-unsigned.cab can also be used if you want to use signing different from VeriSign.

When a browser supporting ActiveX controls opens the HTML page for the first time, it automatically
downloads and installs the ActiveX control on the local PC. This control is downloaded and installed only
once. Later when the same HTML page is opened again, the control is not downloaded again. The browser
only downloads it once more, when the version number of the ActiveX control has changed.

Make sure that the security settings of your browser allow you to
download and run ActiveX controls. 
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HTML Page
In addition to your script (e.g. JavaScript or VBScript), the HTML page must contain the following:

<object
id="cControl"
classid="CLSID:3BB4FE3B-7A37-11D3-A41E-0060080C03B3"    
codebase="<URI>NWWClientFull.cab#Version=4,3,1,0"
align="baseline" border="0" width="750" height="575">
        <param name="BACKGROUND" value="192,192,192">
        <param name="EMBEDDED" value="1">
        <param name="SERVER" value="127.0.0.1">
        <param name="PORT" value="22367">
        <param name="CONNECTION" value="1">
        <param name="ANONYMOUS" value="1">
        <param name="REPOSITORY" value="ESB_Repository">
        <a name="control">Your browser doesn’t support ActiveX controls </a>
</object>

Id Attribute

You can specify any value for the id  attribute. This is the object name which is to be used in your script
in order to communicate with the ActiveX control or to invoke methods of the ActiveX control. Example:

<script language="VBScript"> 
<!-- 
Sub window_onLoad() 
     cControl.connect() 
end sub 
--> 
</script>

Classid Attribute

You must not change the value for the classid  attribute. This value identifies the ActiveX class.

Codebase Attribute

Substitute <URI>  with the URI (Universal Resource Indicator) to the file NWWClientFull.cab. For 
example:

codebase="http://www.myserver/NSW/NWWClientFull.cab#Version=4,3,1,0"

The NWWClientFull.cab file contains all files, including theActiveX control, for running the Entire
Screen Builder Web Viewer on the client side. This file is downloaded and decompressed for the browser
when the HTML page is opened.
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Param Tag

With the param  tag, you can set the values for a property of the control. The default values are used for
those properties that have not been specified.

A detailed description for these properties can be found in the Overview of Client Control Properties
which is part of the User Exits documentation.

See also: HTTP Tunneling in the Installation section.

Other Attributes

The attributes align , border , width  and height  define the object’s appearance in the browser. In
the above code, the object is shown without a border. Its width is 750 pixels and its height is 575 pixels.

You can use all attributes that are supported for the OBJECT element. See your HTML documentation for
further information.
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Customizing the Java Viewer
The Entire Screen Builder Java Viewer runs in the browser of a client workstation. It runs in Netscape
Navigator Version 4.7.3. A prerequisite is that the Java Sun plugin 1.2.2 is installed on each workstation
on which the Java Viewer is to be used. This is provided in the "Redist\SunJava122" folder of the Entire
Screen Builder CD-ROM.

This following information is provided below: 

General Information 
HTML Page

General Information
After installation, the example HTML page ExampleJavaEndUserPage.htm can be found in the Entire
Screen Builder folder "java viewer". This page needs to be customized by the administrator. This folder
also contains the page NoJava122.htm which will appear when the Java Sun plugin has not been installed.

To make the Java Viewer available to all users in your environment, copy the file NWWClient.jar, your
customized HTML page and the file NoJava122.htm to the HTTP server. No installation is required on a
client workstation. Inform all users of the URL that is to be used to open the HTML page.

When a browser opens the HTML page, it automatically downloads and installs the Java applet on the
local PC. This applet is downloaded each time the HTML page is opened.

Make sure that the security settings of your browser allow you to
download and run Java applets. 

HTML Page
The HTML page must contain the following:

<embed type="application/x-java-applet;version=1.2.2"
     align="baseline" width="800" height="600"
     code="NWWClient.class"  archive="NWWClient.jar"
     pluginspage="./NoJava122.htm"
     BACKGROUND="192,192,192"
     EMBEDDED="1"
     SERVER="127.0.0.1"
     PORT="22367"
     CONNECTION="1"
     ANONYMOUS="1"
     REPOSITORY="ESB_Repository"
     SECURE="0"
<noembed>
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Code Attribute

You must not change the value for the code  attribute. This value contains the first class of the Java applet
that is loaded into the browser. 

Archive Attribute

You must not change the value for this attribute.

The NWWClient.jar file contains all classes for running the Entire Screen Builder Java Viewer in your
browser. This file will be downloaded for the browser when the HTML page is opened.

Pluginspage Attribute

The page that is to be shown when the Java 1.2.2 runtime environment is not found on the PC.

Param Tag

With the param  tag, you can set the values for a property of the control. The default values are used for
those properties that have not been specified.

A detailed description for these properties can be found in the Overview of Client Control Properties
which is part of the User Exits documentation.

The following applies to the SECURE property: if you want to use secure HTTP (SSL), the JavaTM  Secure
Socket Extension (JSSE) is also required. You can download it from http://java.sun.com/products/jsse/. 

See also: HTTP Tunneling in the Installation section.

Other Attributes

The attributes align , width  and height  define the object’s appearance in the browser. In the above
code, the object is shown without a border. Its width is 800 pixels and its height is 600 pixels.
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Customizing the GUI Viewers for Open 
Systems
When logging on to UNIX and OpenVMS hosts, the following properties control the way how the logon
credentials are picked up: 

Force Open Systems Logon 
For the Web Viewer and Java Viewer, this property is set in the HTML page. See the sections 
Customizing the Web Viewer and Customizing the Java Viewer. 
For the Windows Viewer, this property is set in the "Client Control Properties" dialog box. See 
Defining the Client Control Properties in the SDK documentation. 
This property can also be set with an Entire Screen Builder user exit. See Overview of Client Control 
Properties in the User Exits documentation. 

Use logon credentials above 
This property is set when defining host sessions using the System Management Hub. See 
Communication Properties for Open Systems in the Administration documentation. 
The logon credentials (user ID and password) to be used are specified in the same dialog as the
property "Use logon credentials above". 

Values from client 
These are the logon credentials (user ID and password) that the user enters in the "Open Systems
User Authentication" dialog box. The "Open Systems User Authentication" dialog box is only shown
if the property "Force Open Systems Logon" has been enabled.

The following table shows the possible combinations of the above properties.

Force Open Systems 
Logon

Use logon credentials 
above

Values from 
client

Action 

On Off Filled Send values from client. 

On Off Empty Send empty string. 

On On Filled Send values from client. 

On On Empty
Send values from session
profile. 

Off On Not applicable
Send values from session
profile. 

Off Off Not applicable Send empty string. 

Two different types of logon dialog box may appear: one for specifying the Open Systems logon
credentials (see above) and, before that, another for specifying the user name as defined with the System
Management Hub (when anonymous logon is not enabled); see Users in the Administration 
documentation.
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The following graphic explains the user authentication process:
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Working with the GUI Viewers
The information in this section applies to the Web Viewer, Java Viewer and Windows Viewer.

The following topics are covered below: 

User Authentication 
Elements of the Viewer Window 
Reloading the Rules 
Printing the Contents of a Host Screen 
Transferring Data Using the Clipboard 
Invoking Help for an Application 
Terminating a Host Session

User Authentication
The Web Viewer and the Java Viewer run in a browser. Ask your administrator which URL to use to open
the HTML page which connects you to a specific viewer. The Windows Viewer runs as a Windows
application, see Invoking the Windows Viewer.

The following graphic explains the user authentication process for a mainframe host (the user
authentication process for an Open Systems host is explained in Customizing the GUI Viewers for Open 
Systems):
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When a user name is required for connecting to the Entire Screen Builder Server, the "User
Authentication" dialog box appears. 

The administrator defines whether this dialog is to appear or not. It does not appear if anonymous logon
has been defined.

 To logon to the Entire Screen Builder Server if user authentication is required 

1.  Enter your user name as defined on the Entire Screen Builder Server. 
2.  Enter your password, if required. 
3.  Choose the OK  button.

You are now connected to the host session, with the rights that have been defined for you.

 To change your password 

1.  Enter your user name as defined on the Entire Screen Builder Server. 
2.  Enter your password. 
3.  Choose the Change Password button.

The dialog box unfolds, displaying additional options.

4.  Enter the new password. 
5.  Enter the new password once more. 
6.  Choose the OK  button.

The password is changed and you are connected to the host session, with the rights that have been
defined for you.
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Elements of the Viewer Window
The following topics are covered below: 

Menus 
PF Keys Toolbar 
Status Bar

Menus

For the Web Viewer and Java Viewer, the developer can define whether the dialog is shown inside the
HTML page (embedded) or not. When it is embedded, you can click the right mouse button to invoke a
context menu. When is it not embedded, a menu bar is shown instead.

For the Web Viewer and Java Viewer, the developer can also define that no context menus (also called
popup menus) are shown at all.

The following menus are available:

File Using the commands in this menu, you can print the current host screen and terminate the
host session. 

Edit Using the commands in this menu, you can copy or cut information and paste it in a
different location. 

View Using the commands in this menu, you can show or hide the status bar or PF key toolbar. 

Utilities Using the command in this menu, you can execute and cancel script files. See the Script 
Files documentation for further information. 

Options Using the command in this menu, you can define that the cursor is automatically
positioned to the next edit control when the current edit control has completely been
filled (autoskip). 

Development Using the command in this menu, you can reload the latest rules. 

Help When you choose About from this menu, information about Entire Screen Builder is
shown. 
When you choose Software AG on the Web from this menu, you can check the
Software AG web site for the latest information on products or events.
When you choose Application Help from this menu, you can invoke help for the current 
application if this has been defined by the developer. 
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PF Keys Toolbar

For session types Telnet TN3270 and NWSAA, the system function keys PA1, PA2, PA3, CLR, ATT,
RST and SYS are always shown in the PF keys toolbar. They are not shown for the session types BS2000
and Open Systems.

When the Function Keys rule has been enabled, additional toolbar buttons are shown for the function keys
detected in the current screen.

When the Function Keys Toolbar rule has been used to define images for the different function keys, these
images are shown on the toolbar buttons. When an image has not been defined, a default image is shown.

When a tooltip has been defined, this text is shown when you move the mouse pointer over the toolbar 
button.

Example:
The function key PF1 has been detected. The default image and tooltip are shown. 

 To switch the PF keys toolbar display on and off 

From the View menu, choose PF Keys Toolbar.
When the PF keys toolbar is displayed in the viewer, a check mark is shown next to this menu
command. 

Status Bar

Depending on the transformation rules that have been defined, information from the character screen
(such as message line or date) can be shown in the status bar.

The right side of the status bar shows the following information: 

INS or OVR
You can click this information to toggle the status. This corresponds to pressing the INS key. When
the overwrite function is active, OVR is shown in the status bar and existing text is overwritten as
you type. This function is helpful, if an edit control contains filler characters. 
SKIP or STAY
You can click this information to toggle the status. This corresponds to choosing Autoskip from the 
Options menu. When the autoskip function is active, SKIP is shown in the status bar and the cursor
is automatically positioned to the next edit control when the current edit control has completely been 
filled.

 To switch the status bar display on and off 

From the View menu, choose Status Bar.
When the status bar is displayed in the viewer, a check mark is shown next to this menu command.
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Reloading the Rules
This option is only available when you have installed a development version of Entire Screen Builder.

When the viewer is started, the latest rules are always applied.

You can also reload the latest rules when the viewer is already active. This is helpful, if you have defined
new rules using the SDK and now want to view how these rules are applied.

 To reload the rules 

From the Development menu, choose Reload Rules.

Printing the Contents of a Host Screen
You can print the contents of the current screen on a printer that is defined under Windows. The printout
corresponds to the actual screen as coming from the host. The transformation rules are not applied.

Note:
If you want to print the dialog with all transformation rules applied, you can use, for example, an
application that is able to capture images from your computer screen.

 To print the screen contents 

1.  From the File menu, choose Print .
The "Print" dialog box appears. 

2.  Choose the OK  button to print the current screen. 
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Transferring Data Using the Clipboard
This information only applies to the Web Viewer and Windows Viewer. It does not apply to the Java 
Viewer.

Using the commands from the Edit  menu, you can copy or cut a host screen (or part of it) and paste it
somewhere else (for example, in another host screen or in a PC application such as Microsoft Word). You
can also copy or cut text from a PC application and paste it in a host screen. Cut or copied data is stored
on the Windows clipboard. 

You must first select the desired text before you can use the Cut or Copy command.

The following applies for a host screen: 

You can only cut text from unprotected fields. If protected fields have been selected, they are copied. 
When you use the Cut or Copy command, the content of the clipboard is deleted and replaced with
the new text. 
When you then choose the Paste command, the content of the clipboard is inserted at cursor position. 
You can only paste text into unprotected fields. If the field is not long enough, it is filled up to its
maximum size. Example: the text to be pasted is DISPLAY and the cursor is located in a two
character long input field. In this case, only the first two characters (DI) are pasted into the input
field. 

Unless indicated otherwise, the left mouse button is always used. The right  mouse button is used to select
the Edit  menu commands from a context menu.

 To select part of a host screen 

1.  Move the mouse pointer to the beginning of the text you want to select. 
2.  Press and hold down the left mouse button. 
3.  Drag the mouse until all desired text is selected. 
4.  Release the mouse button.

You can now cut or copy the selected text.

 To cancel the selection 

Click another screen position.
The existing selection is canceled. 

 To delete the selection in an unprotected field 

From the Edit  menu, choose Clear.
Or press DEL. 
The selection is deleted. It is not transferred to the clipboard.
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 To cut the selection and transfer it to the clipboard 

From the Edit  menu, choose Cut.
Or press CTRL+X.
The selection is deleted and transferred to the clipboard. Exception: protected fields are not deleted;
they are copied. 

 To copy the selection to the clipboard 

From the Edit  menu, choose Copy.
Or press CTRL+C. 

 To paste the content of the clipboard into a host screen 

1.  Move the cursor to the position at which the text is to be inserted. 
2.  From the Edit  menu, choose Paste.

Or press CTRL+V.
The content of the clipboard is inserted at cursor position. 

 To undo your last action 

From the Edit  menu, choose Undo.
Or press CTRL+Z.

Invoking Help for an Application
When the developer has created a help file for an application, the user can invoke it when viewing the
application. 

 To invoke help for the current application 

From the Help menu, choose Application Help.
When a help file is found, it is shown. 

Terminating a Host Session
When you quit the viewer, the host session is automatically disconnected. In addition, the View menu
settings are stored in the local registry for the Web Viewer and the Windows Viewer. They are not stored
for the Java Viewer.

 To terminate the host session 

From the File menu, choose Disconnect.
Or choose Close from the Control menu.
Or click the corresponding standard button in the title bar.
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